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System Requirements

- Microsoft Windows® XP 32-bit (Service Pack 2)
- Microsoft Windows® Vista® 32/64-bit

- USB 2.0 Compliant hardware and system

- Display with VGA port (VGA cable not included)
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Important Information

Before you get started, please NOTE:

Do not place Wireless USB devices under direct sunlight or near high heat emitting devices;
Do not place Wireless USB devices near water or wet surfaces to avoid electric hazards;
Do not place Wireless USB devices on any moving or unstable surfaces.
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Package Contents

1 x Wireless USB Host Adapter (for PC)

1 x Wireless VGA Adapter (for Monitor/TV/Projector)
1 x USB 2.0 A to mini-B Cable (3 ft.)

1 x USB 2.0 Extension Cable (5 ft.)

1 x Velcro fabric hook-and-loop fastener

1 x Power Adapter

1 x Quick Start Guide

1 x Registration / Warranty Card

1 x Installation CD (with User Manual)
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Device Overview

Wireless USB Host Adapter

1. LINK: Data Transfer Activity Indicator
a. LED blinks when data is being transferred

2. PWR: Power
a. LED s solid when powered by the PC
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Wireless VGA Adapter,
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1. VGA : VGA Activity Indicator
a. LED is solid when display cable is connected
b. LED is blinking when data is being transferred

N

PWR: Power Indicator
a. LED is solid when power is applied

3. 1-2-3: Status Indicator

a. Single* solid light: device is wirelessly connected to
the selected Wireless USB Host Adapter

b. Single* slowly blinking light: device is searching for
a Wireless USB Host Adapter

. Single* quickly blinking light: device is trying to con-

nect to a Wireless USB Host Adapter

d. Rapidly scroling lights: device is used in wired
mode.

e. Three Simultaneous Blinking Lights: Cable As-
sociation Mode

o

*Only one light at a time. The position of the light indicates
which Wireless USB Host Adapter the device is trying to
communicate with.

9

4. PWR plug
a. Power adapter socket

5. RESET
a. Association history can be erased by pressing and
holding this button for 10 seconds
6. HOST
a. This button is used to select a different Wireless
USB Host Adapter
7. USB connector

a. In wireless mode, this connector s used for cable
association

b. In wired mode, this connector is used for wired
operation

8. WIRELESS/WIRED switch

a. Choose from wired or wireless mode by using
this switch
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Wireless VGA Software Installation

IMPORTANT NOTE:

If installing on Windows XP, Service Pack 2 (SP2) is required, verify that this has been installed before
installing the Wireless VGA kit software.

Before installing the software, please make sure that the Wireless USB Host Adapter and Wireless VGA
Adapter are not connected to the computer, and the Wireless VGA Adapter is not powered.

Step 1 - Insert installation CD into drive on [ Gl i e
your computer.
Step 2 - Select “Software Installation” from [ireies s 0 5 PR —— =
the menu. s At
=88,

Step 3 — Choose installation method.

you want to install the latest software from the
IOGEAR website or if you want to install the
software directly from the installation CD.

The next screen will let you choose whether e
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If selecting Option 2: Download latest software If selecting Option 1: Install directly from CD,

installer from the Web, a web browser window the installation will start automatically.

will launch directing you to the IOGEAR website

where you will find the most up-to-date software. Step 4 -If you previously installed the

Once you download the software, double-click on GUWH104KIT software, then you will be prompted
the .exe file to begin the installation process. to remove the software from your computer.

For more information, please see Appendix.

M b . i
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Step 5 — For Windows XP users, if you do not have Microsoft .NET Framework 2.0 installed, you will be
prompted to have it installed.

. Click “Yes” to install .NET 2.0 Framework.

. Check “License Agreement” and click “Install”.

. Click “Finish” to complete installing .NET Framework 2.0.
. Restart the computer when prompted.

. Eject your CD and go to Step 1.

g~ WN =

Step 6 - Wireless VGA kit software installation procedures.

1. Make sure the Wireless USB Host Adapter is NOT connected to PC, and the Wireless VGA Adapter
is NOT powered or connected to any device.

2. Follow the on-screen instructions. Important: reboot if prompted.

12
Page 12 of 44



Step 7 - Driver Installation for Wireless USB Host Adapter.
A. Make sure the antenna is connected to the Wireless USB Host Adapter.
B. Plug the Wireless USB Host Adapter to your computer via option 1 or 2. Windows will detect the
device and complete the driver installation process automatically.
Option 1:
Plug the Wireless USB Host

Adapter into any available USB
2.0 port on your computer.
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Option 2:

If using with a Desktop PC, plug the Wireless USB Host Adapter into
an available USB 2.0 port utilizing the provided extension cable.
Place the extension cable on a flat surface, preferably the top of the
desk/work area in order to ensure a good line-of-sight signal with the
Wireless VGA Adapter.
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Step 8 - Driver Installation for Wireless VGA adapter e For LCD Monitor / Flat-Panel TV
A.Make sure the antenna is connected to the
Wireless VGA adapter.
B. Connect one end of the VGA cable (not in-
cluded) to the Wireless VGA Adapter, and the
other end to your display’s blue VGA port.
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e For Projector
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C. Plug the power cable into the Wireless VGA adapter. Make sure the Power Indicator LED is solid.
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Windows will automatically install the appropriate
Wireless VGA Adapter drivers.

Change your display’s setting to select VGA as
your input device. Please refer to the operating
instructions supplied with your display.

You may use the included Velcro® fabric hook-
and-loop fastener to attach the Wireless VGA
adapter to your projector or LCD display in order
to ensure a good line-of-sight signal with the
Wireless USB Host adapter.

Congratulations, your Wireless VGA Kit is
ready for use.
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Wireless VGA Display Settings

To change the display settings, right click on the Monitor icon in the Windows system tray.
A menu will appear and you will have the ability to change parameters such as resolution, color quality,
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Video Mode Configuration

By default, your installation will be set with the
best resolution for your computer and will extend
your screen to the right. You may change the
screen mode and the operation mode.

Note: If no output is seen on the monitor
connected to the Wireless VGA Adapter, it may
be in a mode which cannot be displayed by the
monitor. This can happen if the monitor does not
have its supported modes to the Wireless VGA
Adapter. Reduce the resolution of the primary
display until an image is shown.

There are two options to adjust the Resolution,
Color Quality, Screen Rotation, and Extended

or Mirror Mode. One is to click on the IOGEAR
DisplayLink Manager icon in the Windows tray

as shown above, another is to go to Control
Panel, double click on “Display”, then choose
“Settings” tab.

Mirror Mode

Mirror mode duplicates the primary display to the
monitor connected to the Wireless VGA Adapter.

The resolution, color depth and refresh rate of the
primary screen will be replicated to the monitor
connected to the Wireless VGA Adapter. If the
monitor connected to the Wireless VGA Adapter
supports a lower resolution than the primary
display, then a part of the screen is shown on the
mirrored display. As the mouse is moved around
the screen, the Wireless VGA Adapter display will
scroll to the current area.
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To set up the Wireless VGA Adapter to mirror the
primary display:

il ‘ Mot
1. Go to the “Settings” tab of the Display Eina e
Properties page

2. Click on the Monitor connected to the

“IOGEAR Wireless USB VGA adapter”

Ensure that “Extend my Windows desktop

onto this monitor” is Unchecked

4. Click “Apply”

Ersohituny
Lo 13 High

T e 1034 piety

o i ot th bust diipiie?
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Extended Mode & Siplay Baiens =21
1 ot | -
Extended mode extends the desktop across T —— iatytinton|

multiple monitors.
To set up extended mode:

1. Go to the “Settings” tab of the Display
Properties page

2. Click on the Monitor connected to the
“IOGEAR Wireless USB VGA adapter”

3. Ensure that “Extend my Windows desktop
onto this monitor” is checked

o » ssn Enlaig

4. Click "Apply L ] bigh [Rgberiabn =]
The orientation of the screens can also be adjusted Bty ma st -
by dragging the location of the blue screens to M s gebEhe s il |
match the actual physical layout. ) el
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Screen Refresh Rate Configuration

Mardeer Tups'
OGS Wreess LR YA adeprer (LISH O0SE-TONNIT) |

To adjust the refresh rate of the extended screen,
click on “Advanced” and then the “Monitor” tab.

Ui inritor canek talay

Dy st
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Wireless USB Manager

The Wireless USB Manager is a simple and easy-
to-use interface that allows you to manage your
Wireless USB devices and control your Wireless
USB Host Adapter settings. The Wireless USB
Manager can be accessed via the Wireless USB
Manager icon located in the Windows system tray.

To launch the Wireless USB Manager, double
click on the Wireless USB Manager icon. On the

main pane, you will find an icon representing your [ EE—
Wireless VGA Adapter. If your Wireless VGA
Adapter is not connected, the icon will be | et b
grayed out.

| =058
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If your Wireless VGA Adapter is connected and
working, then the icon will change and show the
current signal strength.

The View menu will give the option of what type of devices you wish to display (All Devices, Connected
Devices and Disconnected Devices).

The Options menu will give the option to launch Host Settings window and turn the Wireless USB Host
Adapter radio on or off.

The Help menu offers quick help on how to connect devices to your Wireless USB Host Adapter.
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Wireless USB Host Adapter Settings

To manage the Wireless USB Host Adapter settings, either select “Host Settings” in the “Option” menu of

the Wireless USB Manager application or right click on the Wireless USB Manager icon in the Windows
tray.

e General Settings

1. Enable the Wireless USB radio: turn on or off the

fet WRELESNLI
Wireless USB radio. P
. . b
2. Host name: Change the name of your Wireless PR
USB Host Adapter.

1 Gk e w115 g0
3. Cable association connection rules*: Always,

Never or Ask me each time. By default Wireless

Ty T
Thom s il e gl I miskeos conputen 3 deweiea:
USB will ask you each time to do the cable

WRELESS Usk
association. il
M e zabelantes TEAT] aamaorors
*Note that the cable association function is NOT needed RS S
to run your kit. This function will be used if you purchase
additional Wireless USB devices.
] ]
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e Advanced Settings

Channel selection: this function allows you to
manually set a radio channel (not recommended)
for the wireless communication (combination of
Band Group and Channel).

For optimal performance, the automatic setting is

Hant Bt B S
recommended.

Evarmat: [ 14
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Wireless USB Host Adapter Selection

To use this button, you must purchase at least one additional Wireless USB Host Adapter (GUWAZ200).
The additional Wireless USB Host Adapters not included in this kit will have to go through the association
process before they can be used with the Wireless VGA Adapter. For more information about the
association process, please refer to Appendix - Cable association with other devices .

The “HOST” button on the Wireless VGA Adapter is used to switch between Wireless USB Host Adapters.
By pressing this button, the Wireless VGA Adapter will look for the next associated Wireless USB Host
Adapter in its list and connect to it. The 1-2-3 lights will move to the next position. If multiple Wireless USB
Host Adapters have been associated with the Wireless VGA Adapter, you may have to press the button
multiple times before a connection is made with the desired Wireless USB Host Adapter. Up to 16 Wireless
USB Host Adapters can be associated with your Wireless VGA Adapter.
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Wireless USB Host Adapter Reset

To erase all Wireless USB Host Adapters (except the Wireless USB Host Adapter included in this kit)
associated* to your Wireless VGA Adapter, hold down the “RESET” button on the Wireless VGA Adapter
for 10 seconds. This will cause the Wireless VGA Adapter to erase all Wireless USB Host Adapters that
have been associated from its list. Each Wireless USB Host Adapters will then have to be re-associated
with the Wireless VGA Adapter using the cable association process in order to connect to the Wireless
VGA Adapter again.

*For more information about the association, please refer to the Appendix - Cable association with other
devices.
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Wireless VGA Adapter in Wired Mode

Your Wireless VGA Adapter can also be used in
wired mode. Make sure the position of the
WIRELESS/WIRED switch is in the WIRED
position. Plug the USB cable between your
computer and the Wireless VGA Adapter. The
function is the same as the wireless mode but
data will be transferred through the cable and
does not require the use of the Wireless USB
Host Adapter.
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Frequently Asked Questions

For the latest FAQs, please go to IOGEAR website (www.iogear.com).

1.

Why can't | install .NET?

You may have an older version of .net, preventing the newer one from being installed. Using
Add/Remove Programs or Programs and Features on the Control Panel, uninstall any version
of Microsoft .NET Framework older than version 2.0. Then install Microsoft .NET Framework
from the Wireless VGA kit installer.

My Wireless USB Host Adapter is plugged into my computer and my Wireless VGA Adapter is
powered but | do not see anything on my display. What’s wrong?

Check the Wireless USB Manager to see if there is an icon for your Wireless VGA Adapter. If

there is no icon, try unplugging and plugging in your Wireless USB Host Adapter to reload
the Wireless VGA Adapter driver.
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If you see an icon that is grayed out in the Wireless Still not connected?

USB Manager, try resetting the Wireless VGA Double check that the radio for your Wireless USB
Adapter by unplugging its power cord and Host Adapter is on in the Wireless USB Manager.
plugging it back in. You should see the icon in the
Wireless USB Manager appear in color when it is
connected.

[ _—
| =
Groeeasns i
T .
Tiom e w8 e gt o vectoon Compbens st denerta

B7m row satirtnied TRAF) rmpcrers
A ) e e

WRELESS. U
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3. Why is my video choppy?

If you are experiencing choppy video, try ot WIRELESS LSS
changing the channel or move in your
computer closer to the display.

19 Aty chocs Chanrel Fesmmerded]
Har S [ B o

Exarmat [ 18
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Technical Specifications

Specifications

Function
Operating System Support
PHY Data Rate

Operating Range
Frequency

Number of Channels
RF Modulation Type
Interface

Video Resolution

Video Streaming

GUW2015VKIT
Microsoft XP 32-bit; Microsoft Vista 32/64-bit

53.3Mbps, 80Mbps, 106.6Mbps, 160Mbps,
200Mbps, 320Mbps, 400Mbps, 480Mbps

Up to 30 feet (10 meters)

3.1GHz to 4.8GHz (WiMedia Band Group 1)
7 channels (3 FFI + 4 TFI)

QPSK/DCM

VGA

Up to UXGA (1600x1200) or WSXGA+
(1680x1050)

Up to 720p (720p only available at resolution
1024x768 or lower)
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Screen Mode Extended and Mirror mode

Color Depth 32-bit True Color

USB Specification Certified Wireless USB 1.0; USB 2.0
Association Mode Pre-Association and Cable Association; Stores

up to 16 Associated Hosts

Native Mode For playback of high resolution video

Antenna Type Omni directional

Reset Switch Used for erasing association history by pressing
and holding this button for 10 seconds

Power Consumption Wireless USB Host Adapter: 1.2W; Wireless
VGA Adapter: 3.3W

Max Output Power -41.3 dBm/MHz

Power Adapter 5V, 2A; 100-240VAC
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Limited Warranty

IN'NO EVENT SHALL THE DIRECT VENDOR'S LIABILITY FOR DIRECT, INDIRECT, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OF THE PRODUCT,
DISK, OR ITS DOCUMENTATION EXCEED THE PRICE PAID FOR THE PRODUCT.

The direct vendor makes no warranty or representation, expressed, implied, or statutory with respect to
the contents or use of this documentation, and especially disclaims its quality, performance,
merchantability, or fitness for any particular purpose.

The direct vendor also reserves the right to revise or update the device or documentation without
obligation to notify any individual or entity of such revisions, or updates. For further inquiries please
contact IOGEAR.
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Federal Communications Commission (FCC) Statement

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation. This device is authorized under 47
CFR 15.519 (the FCC Rules and Regulations). The operation of this device is subject to the following
restriction: This UWB device shall transmit only when it is sending information to an associated receiver.
This UWB device shall cease transmission within 10 seconds unless it receives an acknowledgement from
the associated receiver that its transmission is being received. An acknowledgement of reception must
continue to be received by the transmitting device at least every 10 seconds of operation or the UWB
device must cease transmitting.

37
Page 37 of 44



Contact

IOGEAR

23 Hubble

Irvine, CA 92618

P 949.453.8782

F 949.453.8785

Visit us at: www.iogear.com

© 2008 IOGEAR® Part No. M1062

IOGEAR, the IOGEAR logo, are trademarks or registered trademarks of IOGEAR, Inc. Microsoft and Windows are registered trademarks of
Microsoft Corporation. All other brand and product names are trademarks or registered trademarks of their respective holders. IOGEAR makes
no warranty of any kind with regards to the information presented in this document. All information furnished here is for informational purposes
only and is subject to change without notice. IOGEAR, Inc. assumes no responsibility for any inaccuracies or errors that may appear in this
document.
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Appendix

I. Compatibility with IOGEAR GUWH104KIT

Important: To retain the functionality of both the Wireless VGA kit and the GUWH104KIT, you MUST follow
these steps:

1. Uninstall the GUWH104KIT software by using Add/Remove Programs or Programs and Features on
the Control Panel. Please select and remove “Ultrasuite with WiCenter Basic”. The Wireless VGA kit
installer will not allow you to proceed until this software is removed.

2. Complete the installation of the Wireless VGA kit as shown in the Wireless VGA Software Installation
section.

3. Install the GUWH104 software “Driver Hub Only” for your Wireless USB Hub from IOGEAR
website. Please make sure that you are in the correct product page.
http://www.iogear.com/support/dm/driver/GUWH104+#display

4. Use the Wireless USB Host Adapter (GUWA200) that comes with this kit to communicate with your
Wireless USB Hub.

Note: After this upgrade, the Wireless USB Host Adapter (GUWA100U) will not function with the
Wireless VGA Adapter (GUW2015V) or the Wireless USB Hub (GUWH104) on the PC system
where the GUW2015VKIT software has been installed. However you may use this Wireless USB
Host Adapter (GUWA100U) on a different PC.

For more support information, please contact IOGEAR.
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1. Cable association with other devices

Association Concept:

In order to establish a secure wireless connection, between both the Wireless USB Host Adapter and the
Wireless USB devices, you will need to go through the cable association process. The association process
will allow the Wireless USB Host Adapter and the Wireless USB device to exchange security information
about each other necessary to operate in a secured wireless mode.

Note: Your Wireless USB to VGA Kit has been pre-associated for your convenience and the
process described below has been done for you.

Association Process:

If you purchase additional Wireless USB devices, you will have to associate them with your Wireless USB
Host Adapter. Refer to your Wireless USB device documentation for more information on its settings for
cable association.
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Cable association steps:

. Make sure that the Wireless USB Manager is running. Check your Windows tray for the Wireless
USB Manager icon.

2. Power on your Wireless USB device.
3. Connect the USB cable between an available

USB port on your computer and your bl Associfion Infemlion
Wireless USB device. . .
4. Complete cable association by pressing the Do e Wisdesn WG
“Accept Association” button when prompted. Association State- Wating for a respanse...
5. Remove the USB cable from your Wireless

USB device and computer then follow
instructions specific to your Wireless USB
device for wireless operation.
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Associated Wireless USB devices will appear as icons in the Wireless USB Manager. When the Wireless
USB device is connected to your computer, the icon will appear in color.

art il
L
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